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GENERALGENERALGENERALGENERAL INFORMATION INFORMATION INFORMATION INFORMATION    

    
This manual outlines the general procedures for the laboratory for the 
whole of the course (ie Semesters 1 and 2) but only provides a detailed 
timetable and experimental description for the first Semester as the 
laboratory courses for the Physics Department are being modernised and 
reorganised and some of the details for the experimental work to be 
undertaken during the second Semester have yet to be finalised.  
 
An addendum to this manual will be issued during the first Lab session 
for each group in the second Semester. 
 



Physics EE1 2006-07 Lab Manual 

 4

 



Physics EE1 2006-07 Lab Manual 

 5

EE1 Laboratory Timetable 
 

Experiment Schedule 
 

  Group 

Week Dates A B 

3 
IT 

12th October 
 

Lab Introduction 
Computer Log-on 
IT Assignment 

  

4 
Experimental 

Tutorials 1 
19th  October 

 

 Lab Introduction 
Computer Log-on 
IT Assignment 

5 
Experimental 

Tutorials 2 
26rd October 

 

Dynamics: 
Glider & Pulley  

Thermal: 
Thermal Conduction 

 

6 
Experimental 

Tutorials 3 
2nd  November 

 

  Dynamics: 
Glider & Pulley  

Thermal: 
Thermal Conduction  

7 
Experimental  

Tutorials 4 
9th November 

 

Dynamics: 
Momentum & 

Impulse 
  Thermal: 

Boyle’s Law    

 

8 
Experimental  

Tutorials 5 
16th  November 

 

 Dynamics: 
Momentum & 

Impulse 
  Thermal: 

Boyle’s Law    

9 
Experimental  

Tutorials 6 
23rd November 

 

Dynamics: 
Hooke’s Law, SHM 

Thermal: 
Heat Loss 

Mechanisms          
 

 

    



Physics EE1 2006-07 Lab Manual 

 6

  Group 

Week Dates A B 

10 
Experimental  

Tutorials 6 
30th November 

 

 Dynamics: 
Hooke’s Law, SHM 

Thermal: 
Heat Loss 

Mechanisms         
 

12 15th December 
Hand in IT,  report 

and 
 notebook! 

Hand in IT,  report 
and 

 notebook! 

 

EE1 Laboratory Times 
 

Monday  

Tuesday  

Wednesday  

Thursday 14:00 - 16:30 

Friday  
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EE1 Laboratory Assessment and Deadlines 
 
You will be assessed on the basis of the following items: 

1) Lab records – records written in the lab of each of the experiments you have 
performed. 

2) IT Assignment – the record of your IT assignment, printed out and handed in 
on paper. 

3) A laboratory report – a word processed write-up of one of the experiments 
Guidelines for the report are given in the appendix. 

 

Task Date for completion Marks 

Lab records   
End of each lab, 
Book handed in 
Friday, 15th  December 2006 

60 

IT assignment  Friday, 15th  December 2006 20 

Lab Report Friday, 15th  December 2006 15 

TOTAL  
(Scaled to 10% of degree mark) 

 95 

 
N.B. Your laboratory notebook(s) must be handed in at the same time as your 
report to allow checking of your final assessment mark.  
 
A second appraisal of the same format will take place at the end of the 
Laboratory work in Semester 2 to give a total Laboratory work contribution 
20% of the degree examination mark. 
 
 

Guidelines 

Attendance 
 
� It is your responsibility to ensure that there is a record of your attendance at the 

labs. If your attendance is not recorded you will not receive marks for your 
laboratory work. 

 
� If you do extra work, you must ensure that your attendance is recorded either by a 

demonstrator or a technician. 
 
� You must obtain approval from a technician for work outside normal lab 

hours for insurance purposes. 
 

Submission of work 
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� All work must be handed in on, or before, 16:00 on the date indicated in the 
deadline table. 

 
� You must hand your work to the technician and sign to say that the work has been 

handed in. 
 
� You will receive a receipt to say that the work has been received. 

 
� No credit will be awarded for work, where the sheets are not signed and the 

student cannot produce their receipt. 
 
� The penalty for late work is that 10% of the assessed mark for the submitted 

material will be lost per working day overdue; the possible credit will 
therefore taper to zero in 10 working days. 

 

Lab records 
 
� Hand in your notebook at the end of each experimental day so that your marks can 

be entered into our spreadsheet. 
 
� Include printouts of relevant tables and graphs in your log book and save them to 

your account / email them to your lab partner. The saved version is useful as you 
will need these at the end of term to perform your laboratory write-up. 

 
� You must hand in your book at the date shown in the deadline table since this is 

part of your final grade assessment. 
 

Lab reports 
 
� Lab reports must be submitted in accordance with the rules above. 

 

IT Assessment 
 
� Rules for submission are the same as for the lab reports. 

 
� If no submission for an IT assessment is received, your name will NOT be 

included in the list of exemptions from the need to sit the "Certificate of Basic 
IT competence". 

 

Minimum Performance 
 
You may be refused credit for Physics EE1 unless: 
 

1. You submit at least 50% of the work to be assessed.   
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2. There is recorded evidence of your attendance at 50% of the lab sessions. 
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Introduction 
 
The work of the laboratory sessions integrates problem solving tutorial questions with 
related experiments. The questions and the experiments reinforce the work you are 
covering in your lecture courses. 
 

Aims 
 
� To demonstrate the basics of experimental physics. 

 
� To develop skills required for the clear presentation of scientific results. 

 
� To develop problem solving techniques. 

 
� To experimentally demonstrate concepts discussed in lectures. 

 
� To encourage group-work as a means of effective problem solving. 

 

Objectives 
 
At the end of this laboratory course you should be able to 
 
� record experimental data properly; 

 
� present data in graphical from; 

 
� take effective notes during an experiment; 

 
� know how to estimate the uncertainties in measurements; 

 
� present a word-processed report on an experiment; 

 
� assess the quality of experiments through group discussion. 

 

Demonstrating and Marking 
 
Each experimental tutorial is supervised by one demonstrator, who is usually a 
research assistant or  PhD student. In addition there will be at least one member of the 
academic staff during any lab session. Marking of your lab records will be done by 
the demonstrator for your experiment or staff member on duty. The end-of-term 
reports are marked by demonstrators or staff. 
 
There are ten marks available for each experiment. Each numbered point in the 
experiment is marked. The numbered points usually account for eight (sometimes 
nine) of the available ten marks. The other marks are discretionary and are awarded to 
students who, for example, produce an error analysis, make interesting suggestions 
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about the future use of the experiment or perform the optional extra parts of the 
experiments. 
 

Experimental Tutorials 
 
� Three experimental tutorials are carried out in each lab session.  
 
� Each experimental tutorial is timed to last fifty minutes. Please use the times for 

each section to ensure that you keep on track to finishing the experiment.  
 
Before coming to the lab sessions 
 
� Read the notes on the experiment in this manual. 

 
� Read any references cited. 

 
� Make a first attempt at the tutorial questions, you can discuss with your fellow 

students and demonstrators to refine your answers during the allocated time in the 
session.  

 
� Each experimental tutorial also has a list of further work questions from the 

example book and the mastering physics system – use these to practice the 
material before the sessions and to reinforce the material after the session. 

 
� Preparing well in advance will allow you to complete the experimental tutorial in 

the hour and to try the optional further work sections. 
 

Lab partners and groups 
 
� You carry out the experimental work with a lab partner. 

 
� You can discuss the experiment with others, and indeed some sessions require you 

to work as a group to complete the tasks in the experimental tutorial. 
 

Safety 
 
� You must obtain a copy of the departmental safety regulations, and sign a receipt. 

 
� Any breakages or accidents should be reported to a member of staff or the lab 

technicians. 
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IT skills and the Departmental PC Clusters 
 
The Physics Department has several Open Access Computing Clusters which you will 
be able to use at your own convenience, provided the computers are not being used 
for class teaching.  
 

Attendance 
 
You are required to 'sign-in' and 'sign-out' on the attendance sheets provided. If you 
do not attend a lab, you will receive no marks for that lab. 
 

Missed a lab session? 
 
If you miss a lab because of  a medical problem or any other valid reason, you should 
follow the University code of practice at the back of this manual.  
 
YOU MUST ALSO: 
 

1. HAND A COPY OF THE SELF CERTIFICATE TO A TECHNICIAN OR 
STAFF MEMBER 

 
2. ARRANGE AN ALTERNATIVE TIME WITH A TECHNICIAN TO 

COMPLETE THE WORK YOU HAVE MISSED 
 
If it is not possible to re-schedule your missed lab work, you will be awarded a mark 
for the lab based on what you hand in, provided you have followed the correct 
procedures. In this case your lab book must contain a statement explaining why 
you were unable to reschedule the missed work. 
 

Problems 
 
� Specific problems relating to the experiments should be discussed with 

demonstrators or staff on duty. 
 
� General difficulties should be taken to the lab head. 
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IIII....TTTT.... IN THE  IN THE  IN THE  IN THE PPPPHYSICS HYSICS HYSICS HYSICS CCCCONTEXTONTEXTONTEXTONTEXT    
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Aims 

 
� To realise the potential of Microsoft Word and Excel as tools for the understanding 

of Physics. 
� To gain experience in using various scientifically-useful functions of Word and 

Excel. 
� To use Word and Excel to create components of a laboratory report. 
� To introduce the mastering physics tutorial system 
� To provide material to allow exemption from the Certificate of Basic IT 

competence. 
 

Introduction 
 
In the EE1lab you are required to submit reports on a subset of the experimental work 
which you carry out in each module. You are also required to make use of 
spreadsheets to analyse data during some of the experiments. The primary aim of the 
exercises presented here is to help you learn (or revise) the skills needed for these 
requirements. Note that the laboratory experiments rely on the fact that you are 
already skilled at entering equations and producing graphs in Excel, so you need to 
learn these skills before the 1st week of experiments. 
 
The university also requires that each student attain a 'Certificate of Basic IT 
competence' before entry into 2nd year. By adequately completing the tasks in this 
exercise you will have shown IT competence and will have your name added to a list 
which will be forwarded to the IT Education Unit in the university and you will 
automatically gain exemption from their course.  
 
Since the amount of previous experience students have is quite varied, this exercise is 
self-paced. You are under no pressure to complete everything in the timetabled 
session, all you are required to do is to submit your assignment at the end of term (see 
timetable). Please note, though, that demonstrator help will only be available during 
the timetabled sessions.  
 
Note, you are free to use any of the Departmental Open Access Computer Cluster PCs 
at any time and are encouraged to check your email and the moodle site regularly.  
 

Getting started 
 
Before beginning any of the exercises, you will need to login into a PC on the 
University network, and start the appropriate applications. You will be told how to do 
this at the introductory lab session. Please ask a demonstrator if you experience 
problems1. 
 
All the information you require to carry out these exercises is provided within this 
document.  However, additional help with using IT packages is offered by the IT 

                                                
1You will need to be processed by the registry before you can login in to the university network. 
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Education Unit in the University. The following web address contains links to short 
help sections: 
 

http://apps.iteu.gla.ac.uk/ITEU/html/topups/index.jsp 
 
You may find it helpful to have this displayed in a web browser as you go through the 
exercises.  This web link is only for help perform the exercises in this book not those 
on that web page. 
 
As a first step, please use a browser to navigate to the EE1 Moodle site at  
http://moodle.gla.ac.uk/physics/moodle/ and enrol yourself in the class. The enrolment 
key (that you will be asked for when you first access the P1 area of Moodle) is 
Physics EE1. Moodle is the medium through which all material and announcements 
relating to the class will be communicated, so it is important that you get into the 
way of accessing it regularly.  
 
 

1. Using Microsoft Word  
 
Microsoft's Word package is the most commonly used word processor. In this 
exercise you will be introduced to some of the useful functions the package possesses 
for scientific writing.  These will be vital for writing your laboratory reports.   
 
A good, thorough laboratory report contains diagrams of experimental set-ups, 
equations, tables of results and so on.  Here you will learn how to create these 
elements electronically. 
 
Sections 2.1 and 2.2 instruct you in the use of a series of these tools, teaching you 
what they can do and how to use them.  Once you have gained this experience, section 
2.3 asks you to employ those skills in four exercises.  Your attempts at these exercises 
must be saved in a word document and presented for marking. 
 
Important note – remember to save your work frequently on to the floppy disk you've 
been provided with! 
 
1.1 Drawing diagrams. 
 
Here you will use the Microsoft Draw package.   
 
1.1.1 Creating objects 
 
� The first step is to bring up the drawing toolbar.  To do this, click on View → 

Toolbars → Drawing.  This toolbar contains several buttons.  Run your mouse 
along the icons to learn what each does. 

 
� Click on the Line button.  When you move the mouse back over the page, a + will 

appear. A line is drawn when you depress the left mouse button and drag + across 
the screen. The line terminates by releasing the mouse button.  Holding down the 
shift key together with the left mouse button will produce a horizontal, vertical or 
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o45  line. 
 
� Now draw a rectangle, an ellipse and an arc.  You can vary the sizes of all these 

shapes by clicking on one edge or corner and dragging. 
 
� Microsoft Draw does not restrict you to fixed shapes.  Find the freeform and 

scribble buttons and draw a couple of random shapes.   
 
� Having now created your Microsoft Draw masterpiece, you can give it a title by 

inserting a text box.  Click on the Textbox button and then click the mouse 
somewhere on your page.  By clicking inside this box you can write your title.   

 
1.1.2 Editing objects 
 
� Click on one of the lines you've already drawn.   Now go to Edit → Copy and then 

Edit → Paste to create a duplicate of that line.  Now click on the Line Style button 
and change the thickness of your line.  Create another copy and use the Dash Style 
button to create a dashed line. 

 
The Line Style and Dash Style functions can be used to alter any of the shapes you 
created.   
 
� Copy a couple of your shapes and experiment with the options. 

 
Draw objects can also be edited by right clicking on the object.  This brings up an 
options window that allows you to specify the size, colour, etc of the object.   
 
� Draw a circle and then use the editing options to change the colour of the circle's 

interior to blue and its boundary line to red. 
 
1.2 Using Microsoft Equation editor 
 
In this section you will be shown how to create three separate equations using the 
Microsoft Equation package.   
 
To insert an equation using the equation editor, click: 
 
Insert → Object → Microsoft Equation 3.0 → O.K. 
 
A box in which you insert the equation and the Equation Editor Toolbar will appear. 
The toolbar is shown below. 
 

 
Type in the following equations: 
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(i) ( ) CABACBA ⋅+⋅=+⋅    
 

� Type A into the Equation Editor box. Select   with the mouse and, keeping 
the left mouse button depressed, move the mouse pointer to the appropriate 
symbol. When you release the mouse, the symbol will be inserted.1,2 

 

� Select  and as above enter (   ) into the equation. 
 
� Type B+C inside the round brackets. 

 
� Complete the equation inside the Equation Editor box. 

 
� Return to your word file by clicking outside the Equation Editor box twice. 

 
It is possible to edit the text of an equation by pointing at the equation with the mouse 
and double-clicking.  
 

(ii) k
dz
dfj

dy
dfi

dx
dff ++=∇  

 

� The  symbol  is obtained by selecting  from the Equation Editor toolbar. 
 
� The expressions with a numerator and denominator (the partial derivatives) are 

obtained by selecting  , and the underscore defining the unit vectors by 

selecting  . Highlight the text to be underscored, then select the appropriate 
symbol. 

 

(iii) ∫=−
2

1

21

U

U
EdsUU   

 

� Here, use  and  . 
 
 
You can copy and paste equations just as you did objects in Microsoft Draw.  Just 
click on the equation you're interested in and select Edit → Copy.  Then click on the 
page where you wish the copy to appear, then select Edit → Paste. 
 

                                                
1 You can also insert the symbol by clicking on the first box, releasing the mouse button, then clicking 

a second time on the symbol you want. 
2 By the way, if you want to add a footnote of your own, click on the appropriate spot in the text then 

go to Insert → Footnote.  (If you are using Office 2003, it's Insert → Reference → Footnote.) 



Physics EE1 2006-07 Lab Manual 

 20

Example – put the equations into a table.   
 
� Click on a line below equation 3, then click on Table → Insert → Table.  This will 

bring up the "Insert Table" box.  Set the number of columns to be 3 and the 
number of rows to be 2, then click on OK.   

 
� In the cells in row 1 type "Equation 1", "Equation 2" and "Equation 3".  Now copy 

equation 1 and paste it into the first cell in row 2.  Repeat this procedure for 
equations 2 and 3. 

 
Have you been remembering to save your file as you've gone?  If not, best do so now! 
 
1.3 Exercises 
 
A) 
 
� Using Microsoft Draw, create the following picture. 

 

 
 

N

M1

T
T 

M2 

M2g 
M1gcosθ

M1g

M1gsinθ 

θ 

Figure  1: Forces acting on a block on a slope. 
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B) 
 
� Below is a sketch a student made in their lab book when they were carrying out an 

experiment to measure the period of a mass bouncing on a spring.  They now have 
to write it up as a report.  Create an electronic version of this diagram. 

 

 
 
 

 
 
 
C) 
 
� Another student is writing a report on an experiment where a glider was slid down 

an air track and its speed noted at two points.  They wish to include a table 
containing the results from their experiment.  The table from their lab book is 
below.  Turn this into a Word table. 

 

 
 
 
 



Physics EE1 2006-07 Lab Manual 

 22

D) 
 
� Reproduce the following equations: 

2

2atuts +=  

 

r
r

QkQF ˆ
2

21
12 =  

 

( )22
1 1

1
∑ −

−
=−

i
iN xx

N
σ  
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2. Using Excel to analyse and present data 
 
Microsoft's Excel package allows you to tabulate and manipulate data which you have 
collected whilst performing an experiment. You can manipulate the data by entering 
equations and graph the results. 
 
Here, as in section 2, the initial sections (3.1 – 3.3) instruct you in the use of a series 
of Excel's tools, teaching you what they can do and how to use them.  Once you have 
gained this experience, section 3.4 asks you to employ those skills in three exercises.  
Your attempts at these exercises must be saved in an excel document and presented 
for marking. 
 
Again – remember to save your work frequently on to the floppy disk you've been 
provided with! 
 
2.1 Handling tables of data 
 
� Open up a web browser and go to the following web site: 

 
http://www.physics.gla.ac.uk/~psneddon/P1X_labs.html 

(This page is also linked from the Moodle site in the Laboratory information section.) 
� Open the file P1X_excel_exercise_A.xls  

 
You should see a spreadsheet with the following information: 
 

  Exam Mark Laboratory Mark Total Mark 
William Baker 68 75  
Sophie Manning 70 72  
Elizabeth Sutton 62 64  
Peter McGann 67 72  
Thomas McCoy 70 81  
Christopher Pertwee 70 75  
Carol-Anne Aldred 77 80  
Bonnie Jamieson 66 68  
Sylvester Eccleston 59 66  
Patrick Davison 61 71  
Jon Troughton 69 71  
Sarah Bryant 79 80  
Katy Sladen 55 59  
Paul Hartnell 48 56  
Nicola Langford 65 78  
Louise Hill 79 86  

 

The spreadsheet details the results of a section of a Physics class giving the lab and 
exam mark of students (marked out of 100). We want to calculate the total result for 
each student for the course. 
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2.1.1 Sorting your data 
 
One of Excel's strengths is its ability to allow you to Sort a set of data in several ways.  
For instance, we could reorder the above data into exam mark order.  However, 
typically a results list is listed in alphabetical order.   
 
� Select all the data (i.e. cells A2 to D17) and then go to Data → Sort and select 

column B and Ascending order.  The table should now be ordered in Surname 
alphabetical order. 

 
Now, technically the Data Protection Act makes it illegal for the University to share a 
student's results with the general public, so before we go any further you need to 
make the data anonymous – i.e. delete the names from this spreadsheet.   
 
� Select columns A and B of the spreadsheet.  (Click on the A, then whilst holding 

down the shift button, click on the B.)  Then go to Edit → Delete.   
 
However, we want some way to identify the students, so each row of data needs a 
number.   
 
� Highlight the new column A, then go to Insert → Columns.  The existing data 

should be shunted one column to the right, leaving a new, empty column A. Label 
the contents of the column in cell A1 by typing in ‘identifier’. Then fill in the 
numbers 1 – 16 down the list. 

 
2.1.2 Calculating the "Total Mark" 
 
The total mark a student gains in Physics is a combination of their mark for their 
exams and their laboratory mark.   It is not a straight addition of the two, though.  The 
exam mark makes up 80% of the total, the labs 20%.  We need, therefore, to scale the 
results on the spreadsheet. 
 
� Insert two new columns between the "Laboratory Mark" and "Total Mark" 

columns.  Label these "Scaled Exam Mark" and "Scaled Lab Mark" respectively.  
If you cannot see the full heading once it's typed, adjust the column width 
appropriately.  This is done by positioning the mouse over the very top of the 
divider line at the right hand edge of the column you want to widen.  Then simply 
click and drag right until you can see the full text. 

 
� To scale the exam mark, enter the following into cell D2: 

 
=0.8*B2 
 

and press Enter.  This multiplies the contents of cell B2 (student 1's exam mark) 
by 0.8, i.e. calculates 80% of that mark. The cell in the spreadsheet should now 
contain the scaled result. 

 
� You now want to do the same for students 2 – 16.  The most efficient way to do 

this is to click your mouse on the bottom right hand corner of cell D2.  Now drag 
the mouse down until all the cells up to and including D17 are highlighted.  When 
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you release the mouse button, these cells will fill in.  Click on any one of these and 
you will see an equation of the same form as above, but with a different cell 
number.  (e.g. B5, B8, etc.) 

 
� Using the same technique, complete the "Scaled Lab Mark" column, remembering 

that you want to scale the laboratory marks to 20% here. 
 
You can now calculate the total mark for each student, by adding the contents of 
columns D and E together in column F.   
 
� Enter =D2+E2 into F2, hit Enter, and then repeat the click, drag, release 

procedure. The column should now contain the final mark of each student 
 
� Sort the data so that the students with the highest total marks are listed at the top.  

 
2.2 Manipulating experimental data 
 
Return to the webpage mentioned in Part 2.1 (or the P1 Moodle site) and open up the 
file P1X_excel_exercise_B.xls   
 
A student carries out an experiment to calculate the acceleration of a moving object.  
They do this by measuring the object's speed, v ,  at various times, t .  The spreadsheet 
you have just opened shows the measured results.   
 
The relevant equation of motion for this object is: 
 

atvv =− 0  
  
where 0v  is the object's initial velocity and a  is its acceleration. If a graph of ( )0vv −  
versus t  is plotted, the gradient of the graph will be the acceleration.   
 
2.2.1 Performing calculations 
 
� On the spreadsheet write "v0" in cell D11, and then "4" in D2.  i.e. D2 has the 

value of the initial velocity. 
 
We are going to put the data for the y-axis of the graph – the values of ( )0vv −   – into 
column C.   
 
� Give the column a suitable heading in C1, then click in cell C2.  Enter the 

following equation: 
 

=(B2-$D$2) 
 

                                                
1 If you want to make the 0 a subscript, click in the cell and select the number.  Then click Format → 

Cells and tick the "Subscript" box.  Click OK, and then hit Enter again to leave the cell. 
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and then hit Enter.  (You're taking the data in the velocity column and subtracting 
the initial velocity.)  Now, as you did in part A, click on the right hand bottom 
corner of C2 and drag down to C9 to fill in the rest of the column.   

 
The use of the "$" signs is vital.  Without them, when you drag down, the cell 
subtracted would move from D2 to D3, D4, etc.  Using the "$" locks the reference to 
the correct place. Try it and see! 
 
2.2.2 Plotting data graphically 
 
You now want to plot the graph of ( )0vv −   vs t .   
 
� Select the time data (A1 – A9), then whilst holding the Ctrl button select C1 – C9.   

 
� Now click on the Chart Wizard icon.  Select XY Scatter → Scatter, then click 

Next. 
 
 
� A preview of your graph should now appear (step 2 of the Chart Wizard).  Check 

the data range is what it should be (i.e. =Sheet1!$A$1:$A$9,Sheet1!$C$1:$C$9), 
then click Next. 

 
� Step 3 of the Chart Wizard allows you to label your graph.  Input suitable x and y-

axes labels, as well as a title for your graph.  Click Next. 
 
� The final step of the Wizard determines where the graph will go.  For this 

example, select Sheet 1 and click on Finish. 
 
2.2.3 Finding the gradient of a graph 
 
To find the gradient of a line drawn in Excel we use a programme called Trendline.  
 
� Right click on any of the data points.  In the menu this brings up, click on Add 

Trendline. 
 
� In the Type tab, select "Linear". 

 
� In the Options tab, select "Automatic" and "Display equation on chart".   Click 

OK. 
 
There should now be a best fit line through the data points and an equation of the 
form y = mx + c (the equation for a straight line of gradient m and intercept c).  Here 
the intercept = 0 and the gradient (= acceleration) = -2ms 8.0 .  
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2.3: Evaluating (and plotting) a complex equation 
 
In this section you are going to plot the following function: 
 

( ) ( )






 −−= 2

2

2
exp

22
1

σ
µ

π
xxf   [*] 

 
This is a Gaussian distribution with mean value µ , and standard deviation σ . 
 
� The first step is to open a new spreadsheet and call it Gaussian.xls 

 
2.3.1 Evaluating 
 
Now we need to evaluate the equation ( )xf  for a range of x  values.  i.e. we need to 
convert the above equation into a form that Excel can recognise and interpret.  The 
following steps will do this by breaking the expression into smaller terms, α , β , and 
γ , where: 
 

( ) 22 2,,
22
1 σγµβ

π
α =−== x  

 

i.e. [*] becomes:   ( )







−=

γ
βα expxf  

 
� In your spread sheet create suitable column headings along Row 1.  e.g.: 

 
 A B C D E F G 
1 mu sigma x alpha beta gamma f(x) 
2        
 
For this example we shall define the mean, µ  (mu), to be 5 and the standard 
deviation, σ  (sigma), to be 2.   
 
� Enters these numbers into cells A2 and B2 respectively. 

 
� Column C will contain your x-values.  The first point is 0.0, so enter this in cell 

C2. 
 
Now we start putting in the equations.  We want to put the equation for α  in cell D2.  

Recall 
π

α
22
1= .  In Excel, this is expressed as =1/(2*sqrt(2*Pi())).   

 
The function sqrt() calculates the square root of whatever is within the brackets.  Here 
this is π2 , or 2*Pi().   
 
� Put the Excel version of the equation α  into cell D2 and click Enter.  Make sure 

you have all the correct brackets in place.  This is vital in Excel.  If there is not the 
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same number of opening brackets as closing brackets, Excel will query your 
equation.  However, if the numbers match it will just calculate whatever you have 
typed, whether those brackets are in the right place or not. 

   
Now we put the equation for β  in cell E2.  Recall ( )2µβ −= x .  In Excel this is 
expressed as =(C2-$A$2)^2.  Here the $A$2 is picking up the contents of cell A2, 
which is the value of  µ .  
 
� Enter the Excel version of the equation for β  into E2 and hit Enter.   In Excel the 

"^" symbol means "to the power", and is applied after the calculation within the 
brackets. 

 
� Now input the equation for γ  in F2. In Excel language,   22σγ =  is expressed as 

=2*$B$2^2.   
 
We are now ready to calculate ( )xf  by combining the equations that have been 
entered into cells D2, E2 and F2.   
 
� Type the following into G2:  

 
=D2*exp(-E2/F2) 

 
In Excel, the equation exp() calculates the exponential of whatever is in the 
brackets. 

 
Now that we have calculated ( )xf  at x = 0.0, we need to calculate it over a range of 
x  values.   
 
� Create a list of x  values from 0.0 to 10.0, increasing in steps of 0.2.  To do this, 

type =C2+0.2 into cell C3.  Then click on the bottom right hand corner of C3 and 
drag the mouse down to cell C52.  When you release the mouse, you should have 
the required list.   

 
� Fill in the corresponding values of α , β , γ  and ( )xf  by repeating the same 

click, drag and release procedure on cells D2, E2, F2 and G2.  Note – the contents 
of Columns D and F should be the same in every cell.  If not, go back and check 
that you have correctly typed in the equation in D2 and/or F2. 

 
2.3.2 Plotting 
 
� To plot this function ( )xf , follow the instructions detailed in Part 2.2.2, selecting 

column C for your x -values and G for your y -values. 
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2.3.3 Using Excel functions 
 
In addition to being able to enter your own equations into Excel, the software comes 
with a range of useful equations, or functions, which you can use.  We've already 
encountered the square root function.  Here we will introduce some of the others. 
 
� Open a new spreadsheet and enter the number 1 – 10 into column A. 
 
� In cell B1, type the following: 

 
=sum(A1:A10) 

 
As the name of the function implies, this function adds up the contents of the cells A1 
through A10.  If this number is then divided by 10, the average of the series of 
numbers is obtained.  It's not a very efficient way to find the average though. 
   
� In cell B2, type the following: 

 
=average(A1:A10) 

 
This calculates the average directly.   
 
These are just two examples of the functions available.  A full list can be found by 
going to Insert → Function. 
 
 
 
2.4 Exercises 
 
A) 
 
� Go back to the table of data you created in Exercise 2.3C and copy it into a new 

Excel spreadsheet. 
 
� Insert a new column between the time and acceleration columns and give it the 

heading a – calculated.  (Make sure you can see the full heading.)  From your 
knowledge of dynamics, create an Excel equation to generate an acceleration 
value for each set of data.  Format the resulting values so that they have the same 
number of decimal places as the rest of the data.  Does this match with the 
numbers in the original acceleration column? 

 
� Calculate the average value for each of u , v , t  and a . 

 
� Now calculate the error on this average by using the stdev function. 

 
� Format the averages and errors to the same number of decimal places as the 

original data.  Then format the error cells to show an extra decimal place – what 
do you notice?1 

                                                
1 See the danger of rounding! 
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B) 
 
A student has carried out a simple experiment to test Ohm's Law.  They built a series 
circuit containing a single resistor and a variable power supply.  They varied the 
voltage across the resistor, and monitored the current for each voltage.  Their data is 
given below.   

V(V) I(mA) 
0 0 
1 1.4 
2 3 
3 4.6 
4 6.1 
5 7.3 

 
� Plot a graph of current against voltage, clearly labelling the axes. 
 
� From the graph, determine the value of the resistor. 

 
A second resistor is now added to the circuit in parallel to the first.  The total 
resistance of this combination is given by the following equation: 
 

21

111
RRRtotal

+=  

 
� Using Excel, calculate the total resistance of this new combination, taking the first 

resistor’s value you determined and the letting the second resistor vary from 
Ω 100  to Ωk 1  in Ω 100  steps. 

 
C) 
 
� Evaluate the following function between 0.0=t  and 0.50=t  in steps of 0.5. 

 








 −=
− RC

t
eCQ 1ε  

      ( V 5=ε , F 101 6−×=C  and MΩ 10=R .) 
 
� Plot this function, clearly labelling the axes. 

 

3. On-line library resources 
 
This section uses the standard text for 1st year Physics not the text for EE1 but the 
information is just as comprehensive. 
 
The ITEU material for this part can be found at: 
 

http://apps.iteu.gla.ac.uk/ITEU/html/topups/intro1.jsp 
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� Access the university library's website – the link to this can be found from 
 

http://www.gla.ac.uk 
 
� Click on the Merlin-Catalogue link and carry out a Title search on 'University 

Physics'. 
 

� Now perform an Author/Title search on University Physics by Young and 
Freedman.  

 
� Now use the Keyword option to obtain a list of references relevant to a topic 

within one of your subjects of study. Mark some of the references, then email 
them to yourself. 

 
� Open up your mail application and copy the text you have received. 

 
� Open up your word document from part 2 and paste the e-mailed library 

information into it. Preface it with the heading 'Possible References'. Save the file 
again. 

 

4. Searching the WWW 
 
� Find the University's collection of Subject Indexes and select the BUBL Link 

Subject Tree.  
 
� Follow the index links through to the "Physics: general resources section".  You 

are now presented with a short list of external links, accompanied by short 
descriptions of each website. Select one site and see how well that site matches its 
description. Copy the web address of the site into your word document. 

 
� Return to the Subject Gateways page and select the link to HERO – the Higher 

Education and Research Opportunities in the United Kingdom website.  Now see 
if you can find a useful link on this web site. If you find something quickly, you 
can try to find some other sites here or explore some other Subject Indexes.  
Again, put the address into your word document. 

 
� Go to the list of search engines on the Merlin pages (under "Information 

resources"). Access Google and search for web pages on the subject of Optics. 
Now repeat the search, but add the term Quantum. Put the top three links from 
each search into your word document. 
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5. Finishing off 
 
When you have completed the material from each of the above sections, save the 
file(s), and print out: 
 
� Your word document:  we recommend that this document contains all your work 

from the Word section.  Certainly, it must contain your attempts at exercises 2.3 
A-D.  In addition, don’t forget to include the Mastering Physics section. 

 
� Your excel spreadsheets: again we recommend printing out all the work you have 

carried out and must contain your attempts at exercises 3.4 A-C.  Make sure that 
you print both tables and, where appropriate, graphs clearly.  Check what you'll be 
printing using the Print Preview option. 
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EXPERIMENTSEXPERIMENTSEXPERIMENTSEXPERIMENTS    

Dynamics    
Glider and Pulley 
 
Aim 
 
� To show the versatility of standard dynamical equations. 
� To determine the mass of the glider, from the dynamics of the system. 

 
Part 1:Tutorial question (15 mins) 
 
A glider is placed on an air track and attached to a mass hanging vertically over a 
pulley at the other end, as shown in figure 1. This causes the glider to accelerate due 
to the tension in the thread. 
 

 
If the glider has an initial velocity, u , then at some later time t , its velocity, v , is 
given by equation [1]: 
 

atuv +=      [1] 
 
where a  is the constant acceleration of the glider due to the action of the falling mass. 
 
1.1 Sketch the velocity-time graph for the motion of the glider from a point just 

after it has been released until it has passed through both light gates. 
1.2 By considering the area under the graph you have just drawn, show that the 

distance travelled by the glider, s , can be expressed as follows: 
 

2

2
1 atuts +=      [2] 

 
1.3  If the glider is released from rest, how long will it take to travel 1 m when it 

experiences a constant acceleration of -2ms 5.0 ? 
 

Light gate 1 Light gate 2 

Air Track 

string/tape 

mass 

glider 
+ flag 

Figure 1: A glider pulled along an air track by the action of a descending mass. 
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Part 2: Deducing the acceleration of the glider (15 mins) 
 
In this part you will calculate the velocity of the glider at each light gate and then 
deduce the acceleration. 
 
� Ensure the track is level in the horizontal position as shown in figure 1. 
� Note the positions of the two light gates on the side of the air track, hence find 

their separation. 
� The thread should be as close as possible to horizontal between the glider and the 

pulley. 
� Connect the other end of the thread to the mass hanger and hold the glider at the 

 end of the track. 
� Open the EasySense software package, click on Timing, then select Raw Times.  
� Hold the glider at the other end and add a small mass of 5 g to the mass hanger. 
� Once you have clicked Start, let go of the glider. The glider will be accelerated 

along the track, through the two light gates. 
� Stop the glider at the other end and click Stop to end the experiment.  
� Open an Excel spreadsheet and enter the times recorded for each light gate, then 

enter the necessary formulae to calculate the speed at each light gate.  
 
Hint: 
 You will need to know the length of the flag to calculate the speeds at each 
 light gate. 
 
2.1 Using the speeds at the 1st and 2nd light gates, and the time between each 
 passing, calculate the acceleration of the glider. Explain how you deduced the 
 time it took for the glider to travel between the two light gates and comment 
 on your reasoning. 
 
2.2 Using the speeds and the acceleration, deduce the separation of the light gates 
 in your spreadsheet. How well does this compare with the true separation? 
 Comment on any differences. 
 
Part 3: The versatility of dynamical relations (10 mins) 
 
In this part of the experiment you will compare your results with those obtained using 
equation [2] above: 
 
� In a new column of your spreadsheet, use equation [2] to show that the separation 

you calculate agrees well with that from part 2. 
� Add another column to find the acceleration using the above relation and again 

show that your result compares well with that obtained in part 2. 
� Make a printout of your spreadsheet and insert it into your lab book. 
 
3.1 Comment on your results for separation and acceleration. 
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Part 4: Calculating the mass of a glider from the dynamics of the system (10 
mins) 
 
The force accelerating the glider of mass M  is the tension in the thread,T , due to the 
mass suspended from the other end, m .   

 
 
4.1 Using Newton's 2nd law, and assuming that the tape cannot stretch, derive an 

expression for the glider in terms of a , g  and m .   
 
4.2 Now weigh the glider and discuss how well your estimate agrees with this. 
 
Part 5: Measuring the acceleration due to gravity, g . 
 
The equation you have derived in 4.1 can be rearranged to express the acceleration 
due to gravity g  in terms of the mass of the glider and the suspended mass.   
 
5.1 Using both the actual mass of the glider and that calculated in part 4, calculate 

a value for g .  How well does this agree with the accepted value of -2ms 81.9 .  
Discuss the possible sources of error which result in any mismatch between 
calculation and reality. 

 
 

 
 

Glider & 
flag 

Strong thread 

Tension, T 

T 

mg 

Air pulley 

Figure 2:  A constant force can be applied to a glider by using 
recording tape, an air pulley and a small hanging weight. 
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Hooke's Law and Simple Harmonic Motion 
 
Aims 
 
� To study the oscillations of a mass suspended at the end of a spring.  
� To study Hooke's law in the extension of a spiral spring. 
� To analyse experimental data by graphical methods. 

 
In this experimental tutorial you will first undertake a tutorial question to predict the 
motion of and force on a mass oscillating on the end of the spring, and then perform 
an experiment to measure these quantities. 
 
Part 1: Tutorial Question (15 mins) 
 
A mass is attached to the lower end of a spiral spring and oscillated vertically with 
simple harmonic motion such that its displacement relative to is mean position, x , is 
given by  
 








= t
T

Ax π2sin      [1] 

 
where A  is the maximum displacement and T  is the period.   
 
1.1 Sketch the motion, clearly marking A  and T . 
 
The force, F , due to the extension of the spring from its mean position is given by 
Hooke's Law: 
 

kxF −=       [2] 
 
where k  is the spring constant.   
 
1.2 Hence, add a graph of force to your sketch. 
 
The time period of the oscillations is given by  
 

k
mT π2=       [3] 

 
1.3 If the period is 0.5 s and the mass is 2 kg, what is the value of the spring constant? 
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Part 2: Taking data (10 mins) 
 
In this experiment the position of a mass suspended 
on the end of a fixed spring is monitored used data 
logging software on a PC.  An ultrasound sensor1 
monitors the position.  A force sensor monitors the 
force. 
 
To start data taking: 
 
� Click on EasySense software icon. 
� Select EasyLog from New Experiment menu. 
� Check that the software has detected the force 

and motion sensors – look for corresponding 
boxes in top left of screen. 

� Start the mass bouncing.  Keep the motion as 
vertical as possible – avoid swinging. 

� Wait until the motion has become regular, and then click on "Start". 
� Record data for approximately 20 seconds and then click on "Stop". 

 
Part 3: Calculating period of oscillation and spring constant (5 mins) 
 
� From the Display option on top toolbar select Show Table – this reveals the 

columns of data of time, force and distance. 
� Clicking on a row of the data brings up a marker on the graph.  Using the up and 

down arrow keys, move the marker until it is on a maximum of one of the sine 
waves.  Note down the corresponding time for this maximum.  Now move along 
10 maxima, and note the corresponding time.  

 
3.1 Calculate the average period. 
3.2 Hence calculate the spring constant. 
 
Part 4: Calculating the spring constant from Hooke's Law (20 mins) 
 
In this part you will analyse your data using Excel. 
 
� In EasyLog, click on File – Transfer to Excel.  This opens Excel with your data 

clearly labelled in three columns. 
 
4.1 Use Excel to plot (i) the force due to extension of the spring and (ii) distance 
about mean position against time on a single graph.   

                                                
1 This sends out a signal that is reflected from the base of the suspended mass.  The reflected signal is 
then detected.  The time between emission and detection allows the distance between mass and detector 
to be calculated. 
 

Spring 

Mass  

Ultrasound 
sensor 

Force sensor 

Figure 1: Experimental set-up 
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Hints:  
(a) To calculate the average of a column of data in Excel, use the 

AVERAGE function. 
(b) When referencing a single, specific cell in an Excel equation, use $ 

signs, e.g. $E$2.   
(c) Plot the distance in centimetres so that the scale is similar to that of the 

force on your graph. 
 
4.2 Compare this plot with the graph you sketched in Part 1. 
4.3 From your data for force and distance, use Hooke's Law to calculate values for the 
spring constant. 
 
Hint: 

(d) Consider your columns of data – discard any rogue points.  
   
4.4 From your values, calculate a single, average value for k  and compare this with 
your value from Part 3. 
 
Remember to  save your work to disk and to add your spreadsheet to your lab book. 
 
Part 5: Calculating velocity (Optional) 
 
� Shut down the Easy Sense software, and then reopen it, this time selecting New 

Experiment – Graph. 
� When prompted de-select the force sensor as we are only interested in distance this 

 time. 
� Set the data acquisition to run for 2 s, taking points every 20 ms.  This will give 

you 100 data points. 
 
5.1 Plot this scaled velocity and distance on the same graph.  What is the phase 
difference between these two plots?  
5.2 How can you explain this in terms of the motion and equation [1]? 
 
Hints: 
 

(a) As in Part 2 set the mass bouncing vertically again and let the motion 
settle.  Then start the data taking.  This time you do not need to stop it 
yourself. 

(b) Transfer the data into Excel as before. 
(c) Correct the distance data as before. 

(d) Calculate velocity using 
21

21
tt
xx

−
−

 where 21, xx  are the corrected 

distances for consecutive data points and 21, tt  their times. 
(e) Scale the velocity so that its maximum value is similar to that of the 

distance. 
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Momentum and Impulse 
 
Aims 
 
� To study the conservation of momentum. 
� To investigate the impulse-momentum theorem. 

 
Part 1: Tutorial Question (15 mins) 
 

 
Figure 1 

 
Two gliders on a frictionless air-track are set in motion. The first glider is  travelling 
with a speed u1 to the right, while the second glider is travelling with speed u2 to the 
left. The two gliders collide and move apart with speeds v1 and v2 respectively in 
directions opposite to their incoming directions. 
 
1.1 If the  masses of the gliders are the same, m, and the initial speeds u1 and u2 
 are the same, then what are their speeds after; 
 
 a) An elastic collision, 
 b) An inelastic collision where a fraction x of the energy is dissipated. 
 
1.2 A glider of mass m on the air-track, travelling with speed u, hits a barrier fixed 
 to the air-track, and bounces back with speed v<u. The barrier does not move. 
 What is the total impulse of the collision?  
 
1.3 Make a sketch of force applied to the glider (on the y-axis) against time (on 

the x-axis). What quantity on your graph corresponds to the total impulse you 
calculated? 

 
Part 2: The collision of two gliders (20 mins) 
 
In this experiment you will collide together two gliders on an air-track, measuring 
their velocities before and after the collisions.  
 
� Click on the EasySense software package, select graph from the New Experiment 

 menu. The computer should detect both the light gates – seek help if this doesn’t 
 happen.  

u1 u2 

Light gate 1 Light gate 2 

Air Track 
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� Next, tick the box asking speed at A or B, then enter the length of the piece of card 
 or metal that will cut the light gate. 
� Click finish.  
� Now, start the experiment by clicking on the start button and by gently pushing the 

 two gliders towards each other simultaneously - the metal bumpers at the front. 
� The software will measure the speed of the two gliders before and after the 

 collision i.e. you should see four readings. The gliders should stop at either end of 
 the track on their own accord but you may need to intervene. 
� Enter these velocities into an Excel spreadsheet, distinctly showing values for each 

 glider. 
� Weigh the mass of each glider and add data to spreadsheet. 
� Calculate the total momentum before and after the collision. 
� Calculate the total energy before and after collision. 

 
2.1 Is momentum conserved?  
2.2 Is energy conserved? 
 
Hints: 

Remember to put minus signs in front of speeds travelling in the relevant 
directions. 

 
Part 3: The collision of a glider with a barrier (25 mins) 
 
In this part you will collide the flat side of the glider against a force gauge fixed at 
one end of the track. You will measure the velocity of the glider before and after the 
collision in order to work out its change in momentum. Using the EasySense software 
package and the data colleted by the force gauge, you will be able to plot force against 
time. This will allow you to calculate the impulse and verify the impulse-momentum 
theorem given as: 
 

∫ ∆==
2

1
)(

t

t
pdttFJ  

 
� First, remove one of the light gates from the system and affix the force gauge with 

 the soft rubber attachment to the end of the air-track. 
� Click on the Home button in the top left of the screen, then choose Graph and 

select Next. Choose 10ms total recording time and intervals of 5ms, then Finish. 
� You can now start taking measurements. 
� From the display menu, select show table, then scroll down the cells until you view 

the change in light gate reading from ~3 to ~100. Note the number of 5ms intervals 
until it reverts back to ~3. Knowing the length of the intervening metal/card you 
can calculate the speed of the glider before collision. 

� Scroll down again until you reach the next time the light gate is cut, and note the 
number of 5ms intervals as before. You can now calculate the speed after collision 
in the opposite direction. 

� Enter these values into a spreadsheet along with the mass of the glider. 
� You can now enter formula as before to calculate the change in momentum. 
� Scroll back up the table to where the force gauge reading changes. Click on the cell 

before the change occurs and using the shift key highlight the cells that show 
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negative values until they reach zero again. There may be a subsequent damped 
oscillation which occurs that you don’t want to include in your results. 

� From the menu select use selection then click on the area button from the toolbar. 
� Compare this to the change in momentum of the glider.  
 

3.1 What can you conclude about the comparison between change in momentum 
and the area of force against time?  

 
3.2 Suggest any reasons why your results show deviation. 
 
Hints:  
 Think about the time steps in which the software package takes data – does it 

miss anything? 
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Thermal 

Thermal Conductivity 
 
Aims 
 
� To investigate the thermal conductivity of different metals. 
� To use and manipulate the heat flow equation.  

 
In this experimental tutorial you will first undertake a tutorial question to understand 
the operation of the Heat Flow equation. You will then carry out a series of 
measurements to investigate the characteristics of heat flow and properties of different 
metals. 
 
Part 1: Tutorial Question (15 mins) 
 
When there is a temperature difference between two parts of an object, heat flows 
from the hot part to the cold part of the object in a process called heat conduction. 
 

 
The heat flow H is the rate of 
energy transfer ∆Q/∆t through 
the material. This is 
proportional to the cross-
sectional area A and to the 
temperature gradient ∆T/L. 
Here A is the 2-dimensional 

“width” of the path connecting the hot part of the object to the cold part, and L is the 
length of material the heat passes through. 
 

L
TkA

t
QH ∆=

∆
∆=      [1] 

 
The other quantities appearing in this equation are the energy transferred ∆Q, the time 
taken ∆t, the thermal conductivity k of the material (a measure of how well it conducts 
heat) and ∆T = TH − TC, the temperature difference across the material.  
 
1.1  ∆T can be measured either in degrees Kelvin or degrees Centigrade. Explain 
 why, in this case, these are equivalent. 
 
1.2  Use equation 1 to show that the dimensions (units) of k are Wm-1K-1. 
 
� A metal bar has a width of 9mm and a thickness of 3mm. Calculate its cross-

sectional area in m2. 
 
1.3  A copper bar, of length 10cm width 9mm and thickness 3mm has a thermal 
 conductivity 400 Wm-1K-1. This is connected between two objects whose 
 temperatures differ by 60oC. Calculate the rate of heat flowing through the bar. 
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1.4  The copper bar is replaced by a steel bar with k = 50 Wm-1K-1. What cross-
 sectional area should this bar have to give the same rate of heat flow? 
Part 2: Comparison of thermal conductivities of different metals (15 mins) 
 
Setup the apparatus as shown in figure 2.1 below. 
 
The set of metal bars have temperature 
sensitive strips attached to their front. As 
the temperature increases these change 
from black to cloudy, then to green and 
finally blue. The most sensitive 
indication is when the temperature strip 
changes from black to cloudy. It is 
harder to judge the change of colour to 
green and blue. We are going to immerse 
one end of the bars in hot water and 
measure how long it takes for heat to 
reach the far end of the bar. 
 
As heat is transferred along the bar the 
temperature of successive parts of the 
bar will rise and the colour of the temperature strip will change. This change in 
temperature occurs when each part of the bar has absorbed the same amount of 
energy. 
  
A, L and k are all fixed and we will also assume the heat ∆Q required to cause the 
temperature strip to change colour is a fixed quantity. 
 
� Measure the width and thickness of the four metal bars and check they have the 

same cross-sectional area. 
� Use the kettle to boil some water and then pour the hot water into the pyrex beaker 

until it is roughly half full.  
� Use a thermometer to measure the water temperature to the nearest degree 

centigrade.  
� You want the temperature of the water to be ~ 70-80 oC, so you may need to add 

some cold water to bring the temperature down. Take a note of the room 
temperature as you will need this to determine the temperature difference later. 

� Loosen the correct screw on the clamp stand to lower the metal bars in the beaker 
of hot water to a depth of around 2cm, ensuring the plastic is not immersed, and 
tighten the screw. At the same time start the timer and measure the times ∆tcopper(s), 
∆taluminuium(s), ∆tbrass(s) and ∆tsteel(s) until the top end of the temperature strips on 
each of the four bars turn cloudy.  

 
2.1 Rearrange equation [1] to show the dependence of thermal conductivity k on 
 ∆t and predict whether the ends of the copper or steel bars will heat fastest. 
 
2.2 Evaluate 1/∆t for each bar placed in water with ∆T ~ 50-60oC. This quantity 
 should be proportional to the thermal conductivity of the bar. 
 

Conductivity 
bars 

stand 

Beaker filled 
wit hot water 

Figure 2.1 
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2.3 Given that the thermal conductivity of copper is 390 Wm-1K-1, calculate the 
 thermal conductivities of the other three bars. 
 
Part 3: Conductivity of copper (20 mins) 

 
� Place the metal bars in a bath of cold water and use the digital thermometer to 

measure the temperature of the water. Again an accuracy of one degree will be 
sufficient. 

� Boil some more water in the kettle then half fill the beaker as before. By the time 
the hot water heats the beaker you will find its temperature is somewhere in the 
range 80-90°C. Anywhere in this range is fine. This should give a temperature 
difference with the cold water temperature of somewhere around 70°C.  

� Once the temperature sensitive strips have turned black affix them to the clamp 
stand.  

� Lower the conductivity bars into the beaker so they are immersed ~ 2cm. At the 
same time start the timer and measure the time it takes until the top end of the 
temperature strip on the copper bar turns cloudy.  

� Repeat the measurement on the copper bar using temperature differences of around 
60°C and 50°C. Firstly, cool the bars by placing them in the cold water bath until 
the temperature strips turn black again. By the time you have done this the hot 
water in the beaker will have cooled further. If necessary alter the water 
temperature by adding small additional amounts of hot or cold water.  

 
3.1  Draw up a table of measurements. For each measurement tabulate the 
 temperature difference ∆ T, the time taken ∆t and the product ∆T∆t. 
 
3.2  By rearranging equation 1 discuss what trends do you expect the product ∆T∆t 
 to show? Do your results agree with this prediction? 
 
Part 4: Extension material (optional) 
 
4.1 Here you can gain additional points for successful completion of either (a), 
 (b) or (c). 
 

a) Repeat the investigation of how the time taken ∆t for heat to travel along a bar 
depends on temperature difference ∆T for the brass bar. 

 
b) Taking the values of thermal conductivity for copper and brass, together with 

the time you measured for the whole of the temperature strip on the copper bar 
to turn cloudy, with a temperature difference ∆T of 60°C, calculate the time 
for the whole temperature strip on the brass bar to turn cloudy.  

 
c) The specific heat capacities of the four metals are given in the table below. 

Discuss how the differences between the values for the different metals could 
affect your calculations of thermal conductivities. 

 
Metal Specific Heat

Capacity  
(Jkg-1K-1) 

Density
(kgm-3)

Density x Specific 
Heat Capacity 
(JK-1m-3 × 103) 

Copper 385 8900 3426 
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Aluminium 900 2700 2430 
Brass 380 8500 3230 
Steel 450 7900 3555 
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Heat Loss Mechanisms 
 
Aims 
 
� To understand the different mechanisms of heat transfer. 
� To carry out an experiment demonstrating some of these mechanisms and the 

 properties of different coloured surfaces.  
 
Part 1: Tutorial question (15mins) 
 
1.1 What are the three mechanisms of heat transfer? 
 
1.2 Here are two equations used that describe different types of heat transfer: 
 

l
TkAH ∆=      [1] 

 
4

.TAH εσ=       [2] 
 

State which mechanisms equations 1 and 2 belong to, and, describe what each 
of the symbols represent giving their standard units. 
 

� Three identical metal bottles are placed on an insulated surface and differ only by 
surface colour; one is black, one is white, and one is silver. They are each filled 
with the same volume of boiling water and allowed to cool. 

 
 1.3 Which mechanisms of heat transfer will be significant? 
 1.4 Which bottle will cool quickest and why? Which bottle will cool 

slowest and why? 
    
Part 2: Monitoring water cool in different containers (25mins) 
 
Warning: this experiment uses boiling water.  Please take care when handling 
boiling water to avoid scalding yourself or your lab partner.  Also, please use the 
insulated gloves provided when filling metal bottles or moving them around. 
The apparatus should be set up as follows: 

 
Figure 1 

timer thermometers

bottles

kettle 
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� Firstly, pour at least 1 litre of water in the kettle and switch the kettle on to boil.   
� Use the plastic measuring jug provided to pour some of the boiling water into each 

 of the three metal bottles to heat them up - funnels are provided to ease the pouring 
and minimise spillages. 

� Pour all the water from the bottles back into the kettle and switch it on to boil 
 again. 
 
You will now fill each bottle with 300ml of boiling water but it is important the 
starting temperatures of are the same – differing by no more than 2 °C. The following 
procedure should ensure this for you, if not ask a demonstrator. 
 
� You should now use the measuring jug and funnel to pour 300ml of boiling water 

into the silver bottle, then pour 150ml of boiling water into the white bottle, next 
pour 300ml of water into the black bottle and the final 150ml into the white bottle 
again. 

� Place a digital thermometer into each of the bottles and seal with caps to reduce 
 heat loss by convection. 
� Start the timer and note the temperatures of the black, white and silver bottles – 

check that their temperatures are all within 2 °C of each other. 
� Take temperature measurements of each bottle every minute for a total of 20 

 minutes. These readings should be to the accuracy of the thermometer i.e. one 
 decimal place. 
 
Part 2: Analysis (10 mins) 
 
2.1  Plot a graph of the cooling for all three bottles on the one graph.  Draw a line 

 (curve) of best fit through each set of points. (Please use different symbols 
 and/or colours to distinguish between the three different bottles).  

  
2.2  Which bottle cooled the slowest? Give an explanation for your answer. 

Which bottle cooled the fastest? Is this related to the properties of the colour 
 of the bottle or because the starting temperature differed slightly from the rest? 
 
2.3  What is the dominant heat loss process for the bottles?  
 
Part 3: (Optional) 
 
Take a look at the Crookes Radiometer and observe what happens when light is 
incident upon one side. 
 
3.1 Can you explain the movement of the “paddles” contained within the vacuum? 
 
Hint: 
 One side of the paddle is black and the other is white. 
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Boyle’s Law 
 
Aims 
 
� To investigate the features of Boyle’s Law and the Ideal Gas Law.  
� To confirm theoretical prediction with experimental procedure. 

 
Part 1: Tutorial Question (10 mins) 
 
An ideal gas at a fixed temperature T behaves according to Boyle’s law, which is 
expressed as: 

CpV =      [1] 
 
where p is pressure, V is volume and C is a constant. A cylinder of gas connected to a 
pressure gauge is kept at room temperature, as shown in figure 1. 

 
Figure 1 

 
1.1 At a volume of 1 unit, the pressure gauge reads 10 Ncm-2. Assuming the 

temperature of the air remains constant, what will the pressure gauge display 
when; 

 
(a) the volume of air within the cylinder is increased to 2 units? 
(b) the volume of air within the cylinder is increased to 4 units? 

 
 Part 2: Verifying Boyle’s Law (15 mins) 
 
In this part of the experiment you will take measurements of the gas at room 
temperature, and then by taking subsequent measurements at a different volume you 
can verify Boyle’s law. 
 
The following steps must be done with the pressure gauge of the apparatus sitting 
upright as shown in Figure 1: 
 
� Open the vent by turning the screw anti-clockwise. 
� Move the piston until you have selected a volume of your choice – it may be wise 

 to choose an easily distinguishable volume e.g. 1, 2, 3 … 
� Tighten the vent screw and note the pressure gauge reading. It is important to be as 

 accurate as possible, it may be necessary to gently tap the pressure gauge so as not 
 to read an erroneous measurement. 

Cylinder with piston 

Pressure 
gauge 

Vent 
screw 

Connecting 
body 
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� Change the volume of the air by pulling/pushing the piston at the end of the 
 cylinder. 
� Note both your new volume and the new pressure gauge reading. 

 
2.1 Assuming the temperature of the air inside the cylinder is at the same 
 temperature as initially, verify Equation 1. 
 
Part 3: Tutorial Question (10 mins) 
 
The ideal gas law is given as: 

nRTpV =      [2] 
 

3.1  State what each of the symbols represents. 
 
3.2 What is the dimension (units) of the left hand side of equation 2? Given that a 
 Newton metre, Nm, is dimensionally equivalent to a joule, J, write down the 
 dimensions of R. 
 
3.3 The volume of 1 unit on the cylinder is 610247.1 −× m3, which at a temperature 
 of 300 K, contains 11109.1 −×  moles of air. If the volume is kept constant but 
 the pressure gauge is observed to change from 10 Ncm-2 to 11 Ncm-2, calculate 
 the new temperature of the air. 
 
Hints:   

(a)1 m2 = 10,000 cm2, 1 Nm = 1 Pa, R = 8.315 Jmol-1K-1 
  (b) is there an easy method to do this?! 
 
Part 4: Verifying the Ideal Gas Law (15 mins) 
 
In this part of the experimental tutorial you will change the temperature of the air 
inside the cylinder and keep the volume constant. A change in pressure will occur and 
you will then be able to verify the ideal gas law. 
 
The following steps must be done with the apparatus sitting up right as shown in 
Figure 1: 
 
� Select a reference volume which gives a pressure gauge reading of 10 Ncm-2 and 

 ensure the vent screw is tightly closed.  
� Note this volume in your lab book along with the room temperature. 
� Now raise the temperature of the cylinder by placing it in the basin and covering 

 with a hot water bottle. Please take care when filling these bottles by using the 
 funnels provided to reduce the risk of scalding. 
� It will take around 5mins for the temperature of the gas inside the cylinder to raise 

 enough to make a noticeable difference on the pressure gauge, e.g. 11 Ncm-2. 
� Ensure the volume doesn’t change. It may be necessary to readjust the piston back 

 to the reference volume. 
� Assuming the gas is now at the same temperature of the cylinder, use the infra-red 

 thermometer to measure this temperature. This is best done by taking several 
 readings at different angles and averaging the temperatures showing similarity. 
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4.1 Using the ideal gas law, deduce the relationship between the initial 
 pressure/volume/temperature and the final pressure/volume/temperature.  
 
4.2 Hence, or otherwise, calculate the final temperature of the air within the 
 cylinder and compare it with the temperature you measured. Discuss any 
 causes for deviation. 
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 Appendices  

Records and Reports 

Units1 
You should always use SI units to express results2. In addition, try to ensure 

� your answers are given to an appropriate number of significant figures 
(usually 2 or 3). 

� that you use scientific notation. 

Uncertainties3 
All measurements of physical quantities are liable to uncertainty. When analysing 
uncertainties in this lab, you are expected to be able to: 

� distinguish between random uncertainties and systematic effects (including 
calibration uncertainties). 

� estimate the uncertainty due to scale reading of instruments. 

� know that repeated measurements of quantities are desirable. 

� calculate the mean value of a number of measurements, and use this as the 
best estimate of the "true" value.   

� know that systematic effects can cause the measurements to be offset from the 
"true" value. 

� calculate the random uncertainty in the mean value of a set of measurement 

using ( ) ( )
tsmeasuremen of number

value min.value max.yuncertaint −=  

� express uncertainties in absolute, percentage or relative form. 

� identify the main source of uncertainty in an experiment, and use this when 
appropriate as a percentage uncertainty for the final result of the measurement.   

� express final answers in the form value ± uncertainty 

� compare the numerical result of one experiment with that of another. 

Tables 
Readings and observations should almost always be recorded in a table. Whether done 
roughly in a lab record, or neatly in a lab report, a table should include: 

� A title or caption. 

� Correct column headings. 

� Appropriate units. 

� Correctly entered readings/observations. 

� (for lab reports only) data should be entered sorted with ascending or 
descending independent variable. 

                                                
1  Reference: University Physics 11th Edition: 1-3, 1-4 
2  See "The International System of Units", Appendix A, University Physics 11th Edition 
3  Reference: University Physics 11th Edition; 1-5 
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Graphs 
� Data are usually best seen in graphical form. Both in records and reports, 

make sure that your graphs include: 

� a title or caption. 

� suitable scales, and axes labelled with quantities and units. (Try to aim for 
graphs which fit on one page of your lab notebook - the graph paper side!) 

� data points clearly visible. 

� plot the independent variable on the x-axis. 

� a line of best fit, where appropriate. 

Example 
You are often required to derive results from the gradient or intercept of a straight-line 
graph. As an example, consider the case of the measurement of a spring constant by 
measuring the period of oscillation. It can be shown that the period T depends on the 

mass M on the spring as
k
MT π2= , where k is the spring constant. By varying M 

(the independent variable) and measuring T, we can calculate k by plotting a graph of 
T2 against M. This means that we will have a graph of the form y=mx+c, where 

k
m

24π=  and c=0.  

To calculate the gradient, take two points ( ) ( )222111 ,and, yxP  yxP ==  (not too close), 
then 

12

12

∆ xx
yy

x
ym

−
−=∆=  

[Note that since you do not measure the point M=0, it should NOT be part of the 
fitting process.] 

 

Records 
Lab records are what you will be marked on for each experiment. The following 
section is a guide to producing a good set of records. You should show in a clear way 
the main features of the experiment.  The emphasis is on clear presentation of the 
data, calculations, results and conclusions, NOT a lab report! 

You are marked on the numbered items in the experimental tutorial – so make sure 
these are clearly labeled in your lab book. 

Get a lab notebook (available for purchase in the lab!) - they are either hard- or 
soft-back, with alternate lined and graph-paper pages. 

� You will be given a label to stick on the front cover of your notebook. 

� Each lab record should have: 

� Date of experiment. 
� Title of experiment. 
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� Answers to tutorial questions. 
� Reference to page in lab manual: There is no need to repeat all the 

information in the lab manual. Only draw figures of apparatus or note the 
method you use if you are explicitly asked to do so. 

� Data: In tabular form - see section on tables. 

� Graphs (where appropriate): See notes on graphs 

� Calculations: For each section, show enough details of your calculation so 
that the demonstrator can see how your result is obtained. Values should be 
expressed along with an estimate of the uncertainty. 

� Conclusions: The result(s) for each section should be presented in the section 
with a brief comment including if appropriate a comparison with any accepted 
value. 

� Answers to group questions. 

Example of a Laboratory Record  
The following is an example of how we would expect you to produce a record of an 
experiment on Forces and Accelerated Motion. You should use the example for 
guidance. Note that you are NOT expected to write perfect notes - as long as what 
you write is legible to your demonstrator and yourself! Typed notes are NOT 
appropriate. 

 
Additional notes are shown in italics 
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25.10.99 Forces and Acceleration. 
 
Part A; Static forces. 
The apparatus was setup as described in the lab manual. 
 
 
 
 
 
 
 
 
 
 
 
Diagrams like the one above should be drawn on the graph-paper side of your 
notebook 

 F1 = 14.61 N 
Forces  

 F2 = 8.79 N 

x and y co-ordinates. ( measurements in mm from arbitrary x and y axes). 
(x1,y1) = (220,729) 
(x2,y2) = (271,614) 
(x3,y3) = (444,698) 
(x4,y4) = (361,601) 

i.e. 

o

o

4.49169.1
361444
601689tan

1.66255.2
271220
614729tan

2
43
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2

1
21

21
1

=⇒=
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−
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=⇒=
−
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−
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θθ

θθ

xx
yy
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Component  equations. 

72.5cos
92.5cos

22

11

=
=

θ
θ

F
F

 

 

62.19
03.20sinsin 2211

=
=+

Mg
FF θθ

 

Agreement not exact, but it is reasonable given the errors in measuring the co-
ordinates. 
 

Mg

θ1 θ2 

F1 F2
(x1,y1)

(x2,y2)

(x3,y3
) 

(x4,y4)
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Vector addition of forces. 
 
Masses of the springs:  82.3 and 70.8 gm.  
i.e. vertical downwards force from spring masses = 1.5 N.  
 
Three main forces almost add up vectorially to zero. Masses of springs could account 
for small discrepancies in the vector sum. 
 
 
 
 
  
 

 

Mg

F1

F2

Combined 
weights of 
springs=1.5
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Part B: Free-fall under gravity. 
Time (t) taken to fall a distance (s). 

Measurement 1 2 3 4 5 6 7 8 
s(m) 0.926 0.83 0.727 0.643 0.527 0.44 0.333 0.22
t(s)-1st 0.43 0.41 0.39 0.36 0.32 0.29 0.25 0.21
t(s)-2nd 0.43 0.41 0.38 0.35 0.32 0.29 0.25 0.21
t(s)-3rd 0.44 0.39 0.38 0.36 0.32 0.29 0.25 0.21
t(s)-av. 0.433 0.403 0.383 0.357 0.32 0.29 0.25 0.21
t-sqred (s^2) 0.188 0.163 0.147 0.127 0.102 0.084 0.063 0.044

Graph of t squared against s for free fall
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Using the crosses to define two points on the straight-line fit: 
 

2

2

76.9Hence
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053.0176.0Gradient
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−
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msg 
gm

s
  

 
Accepted value of  g is 9.81 ms-2. 

 

 

X 

X 
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Part C: Simple Pendulum. 
 
Simple Pendulum - Period (T) as a function of length l. 

 
Measurement 1 2 3 4 5 

length(m) 0.533 0.422 0.307 0.212 0.117 
Time(s)-50 swings 24.78 66.92 56.89 47.94 36.57 
Period (s) 1.469 1.338 1.138 0.959 0.731 
Period squared- s^2 2.24 1.79 1.3 0.92 0.54 

 

 

 

2

222
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Accepted value for g is 9.81 ms-2 . 
The two experimental results are in agreement with each other to better than 1% 
 

 

Period squared against length for a simple pendulum
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Part D: The Spiral spring. 
 
Spiral spring constant  : static and dynamic.  
 
Mass (kg) Extn. (m) 50 Vibrtns. (s) Period-T (s) T^2 (s^2) 

0.25 0.08 31.26 0.625 0.39 
0.2 0.06 28.68 0.537 0.33 

0.15 0.04 25.06 0.501 0.25 
0.1 0.02 21.15 0.423 0.18 

Static Measurement. 

Spring extension against mass added

0
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Gradient = 0.4 mkg-1, ie. spring constant 15.24 −== Nm
gradient

gk . 

Graph shows data point to be in a straight line, indicating reasonable measurements. 

y=0.4x-0.02 
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Dynamic Measurement.  

Period squared against mass

0
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Graph shows good straight-line fit. Measurement agrees with previous one to within 
12%. 
 
Conclusions: 

•  It was shown that if a system of forces is at rest, the vector sum of the forces 
is, to a reasonable approximation, zero. Uncertainty in the measurements 
means that the sum is not exact. 

•  The two measurements of g have been found to be within reasonable 
agreement with each other and the accepted value. This shows that the 
measurements were reasonably accurate. 

•  The two measurements of spring constant were found to be within 12% of 
each other. It is not possible to judge which method is better since the actual 
value is not known. 

 

y=1.42x+0.039 
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Reports 
The report should be written in your own words in an impersonal passive style. It 
should be complete and free-standing allowing the informed reader to repeat the 
experiment on the basis of your report alone. It should not include the tutorial 
questions as such, but the material covered in them may be relevant to explaining the 
theory and analysis of your experiment. 

If the experiment has several parts, it is better to describe each part individually, as 
above, and draw the whole report together at the end with a short, overall 
conclusion. 
Examples of previous years' reports will be available in the lab to give you an idea of 
what is expected. Since the IT component of the assessment is based on your reports, 
you must bear in mind that reports 

� should be word processed (using Microsoft Word, or equivalent). 

� diagrams, tables and graphs should be printed.  

� should be printed on A4 size paper and stapled or bound, with your name and 
lab session clearly marked. 

� should not be more than 5  pages in length. 
A typical report may be divided up into the following sections but think first about the 
appropriate structure for your experiment.  

Title (including date) 
 
Introduction 

The aim of the experiment. 

Theory 
Explain and quote the formulae used and state what the symbols mean but 
don't derive the formulae. 

Apparatus  
Describe the experiment briefly. Include  

� a clear carefully annotated diagram. Give diagrams figure numbers and 
refer to them in your text. 

� a description of the apparatus, and instruments used. 

Method  
� For each measurement as appropriate, describe what was varied what 

was measured and how it was measured.  
Results  

� data in tables with a label 

� graphs with a label where appropriate 
Analysis  

� The calculations involved in obtaining the final results. All arithmetic 
details should not be shown but they should be sufficient to enable the 
analysis to be checked. 

� Results should include an estimate of the uncertainties. 



Physics EE1 2006-07 Lab Manual 

 61

Conclusions 
� summarize final results. 

� link the objectives of the experiment with the results obtained. 

� comment on effectiveness of procedures 

� discuss limitations of equipment, and possible improvements 

� discuss sources of uncertainty. 
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EE1 Physics Laboratory Report Feedback 
This section is intended to give you some general tips on report writing, based on 
some of the more common errors seen in reports in the past. 

Use an impersonal style in the passive voice 
This might make what you write sound a bit dull, but it is the accepted convention. Do 
not write things like “I switched the power supply on...”, instead write “The power 
supply was switched on..” 

Choose the correct tense 
Normally when you are reporting on what you have done, you would use the past 
tense. Occasionally, you can use the present tense, if you are describing how 
something works, e.g. “The cathode ray tube works by ... It was switched on at the 
start of the experiment...” 

Write in English prose, not just in note fashion 
Do not write down the method as if it were a recipe (that's what the lab manual is 
for!), but describe as concisely as possible what you did in complete sentences. In 
particular, do not copy the lab manual – this would be plagiarism.  

Be consistent with significant figures and accuracy 
Saying something like “the measured value of g=9.521ms-2 was very accurate 
because it is within 2% of the accepted value” . NO – the implied accuracy is +/- 
0.0005, meaning that the upper value consistent with the measured data is 9.5215. 
This is statistically inconsistent with the value of 9.81ms-2. There is rarely a need to 
quote results to more than three decimal places in the P1X/Y laboratory. 
Write down only the appropriate results 
In a report, tables should adequately summarize the data taken. e.g. in the thermal 
physics experiment, a graph of temperature vs. time would suffice, instead of printing 
out the 60 data points. 

Make graphs big! 
At least half the size of an A4 page; any less is pointless. 

Use the same font size throughout  
Apart from section headings and the like, the body of text should be in the same font 
size to make it look professional. This means symbols in equations as well, but you 
can of course have italicized text, bold text or bold italicized text. 

Use the Equation editor for formulae 
Most word processors have one, and it avoids the need for jumping through hoops to 
get all your symbols to line up. 

Beware of the Microsoft version pitfalls 
If you are going to work on your report at home and in the department cluster, be sure 
that you are able to read things like equations and diagrams in both versions of your 
word processor. Not being able to print out reports because of version 
incompatibilities with home/department packages seemed to be one of the most 
common excuses for handing in reports late!  

Do not include answers to tutorial questions 
-- they are not relevant to the report. However, you may need to include material 
similar to the tutorial question to explain the theory and analysis of the experiment. 
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Do not quote only formulae in the background section 
This is encouraged at school level, but in EE1 we want you to explain the meaning of 
formulae and where they have come from. 
Do not join dots 
If your graph is meant to show a linear relationship, DO NOT join data points with 
straight lines - you should include a best fitting straight line through the points.
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EE1 Physics Report Feedback 
In order to help you understand any problems with your report writing, you will 
receive a form similar to the following when your report is returned to you. 

 

Student Name: ................................................................. 
Matriculation No.: ........................................................... 
 

 Marks1 Comments 

Description of Background 
and Theory 

 (6)

 

Experimental Method and 
Apparatus 

 (8)

 

Presentation of results 

 

 (10)

 

Discussion and 
Conclusions 

(6)

 

Total  
 (30)

 

 

Marked by:............................................................ 
Date:....................................................................... 

                                                
1  Maximum for section given in brackets 
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Plagiarism 
 

The following is the University of Glasgow's Plagiarism Statement: 

The full details can be found at http://senate.gla.ac.uk/academic/plagiarism/ 
In the case of EE1, the above warning is not intended to stop you discussing your 
tutorial problems or laboratory results with your classmates - in fact we encourage 
this.  You should not, however, use someone else's laboratory measurements without 
acknowledging this, and naming the person, in your record book.  The one formal 
laboratory report in each module must be your own unaided work. 

XXXI PLAGIARISM STATEMENT (amended by Senate 6 May 2004) 

Introduction 
31.1 The University's degrees and other academic awards are given in recognition of 
a student's personal achievement. All work submitted by students for assessment is 
accepted on the understanding that it is the student's own effort. 
31.2 Plagiarism is defined as the submission or presentation of work, in any form, 
which is not one's own, without acknowledgement of the sources. Special cases of 
plagiarism can also arise from one student copying another student's work or from 
inappropriate collaboration. 
31.3 The incorporation of material without formal and proper acknowledgement (even 
with no deliberate intent to cheat) can constitute plagiarism. Work may be considered 
to be plagiarised if it consists of: 
• a direct quotation; 
• a close paraphrase; 
• an unacknowledged summary of a source; 
• direct copying or transcription. 
With regard to essays, reports and dissertations, the rule is: if information or ideas 
are obtained from any source, that source must be acknowledged according to the 
appropriate convention in that discipline; and any direct quotation must be placed in 
quotation marks and the source cited immediately. Any failure to acknowledge 
adequately or to cite properly other sources in submitted work is plagiarism. Under 
examination conditions, material learnt by rote or close paraphrase will be expected 
to follow the usual rules of reference citation otherwise it will be considered as 
plagiarism. Departments should provide guidance on other appropriate use of 
references in examination conditions. 
31.4 Plagiarism is considered to be an act of fraudulence and an offence against 
University discipline. Alleged plagiarism, at whatever stage of a student's studies, 
whether before or after graduation, will be investigated and dealt with appropriately 
by the University. 

Referral 
31.5 Where a student is suspected of plagiarism1 the member of staff shall refer the 
case to the Head of Department2 or equivalent (hereinafter referred to as Head of 

1 If a student suspects a fellow student of plagiarism then he or she should speak to a member of staff in the 
department 
concerned. The identity of the student making the report shall remain confidential. 
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2 Where the Head of Department has a potential conflict of interest (eg teaches or examines on the course 
concerned) then 
he or she should pass the case to another senior member of academic staff in the Department. In the case of small 
departments, where it may not be possible to pass the case to another senior member of academic staff, the case 
should be 
passed to the Head of a cognate department. 
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Department) along with all appropriate documentary evidence (the piece of work in 
question duly marked-up, a copy of the original source of the plagiarism, information 
on the contribution of the piece of work to the overall assessment, etc). Any further 
departmental consideration of that piece of work shall be held in abeyance until the 
procedures set out below have been completed. The student shall be informed in 
writing that his or her marks have been withheld pending an investigation of 
suspected plagiarism. 
31.6 The Head of Department shall assess the extent of the suspected plagiarism 
and, if necessary, consult with the Senior Senate Assessor for Discipline. The Head 
of Department will deal with suspected cases that are first offences and not 
considered to be severe. The Head of Department will refer all suspected second 
offences and cases of severe plagiarism directly to the Clerk of Senate or to the 
Head of the Senate Office for investigation under the provisions of the Code of 
Discipline. 
31.7 Whilst there is no definitive list, examples of cases which would be regarded as 
severe plagiarism include: 
(i) any case of serious and or blatant plagiarism when considered in relation to the 
student's level of study and length of exposure to the procedures, practices and 
regulations of the University; 
(ii) a first offence where a reduction in marks would put at risk the student's degree 
or direct progression; 
(iii) any case, regardless of extent, where it is inappropriate to deal with it within a 
department. 

Procedure before the Head of Department 
31.8 At all times the principles of natural justice shall be observed. 
31.9 With respect to cases that are first offences and not considered to be severe, 
the Head of Department shall interview the student concerned. He or she can also 
interview any students who have allegedly allowed their work to be copied. As soon 
as practicable, the student will be informed in writing of the alleged offence and of the 
requirement to attend for interview. The student will also be provided with a copy the 
marked-up piece of work in advance of the interview. 
31.10 The student shall have the right to be accompanied, assisted or represented at 
the interview by one of the following: a parent or guardian; a fellow student or other 
friend; an Officer of the Students' Representative Council; a member of University 
staff, or a legal representative. At the beginning of the interview, the Head of 
Department will ascertain who is to be the spokesperson for the student (the student 
or a representative). The foregoing not withstanding, the Head of Department shall 
have the right to question the student directly, where necessary. 
31.11 The Head of Department shall have a member of support staff present to keep 
a record of the meeting. 
31.12 At the interview, the student will be shown a copy of his or her work, duly 
marked-up and be given a clear explanation of what he or she has allegedly done. 
The student will be given the opportunity to justify the work and be invited to admit 
or 
deny responsibility. 
31.13 If the Head of Department is satisfied beyond all reasonable doubt that an 
offence has occurred he or she may impose an academic penalty, which will take 
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account of the extent of the plagiarism. The Head of Department may reduce the 
marks or results up to the point where the academic rating for the piece of work in 
question is reduced to zero. Consideration will also be given to resubmission 
opportunities; the maximum mark that can be awarded to any resubmission is the 
pass mark appropriate to the degree programme being followed. The student shall be 
given instruction about plagiarism and the necessity of properly acknowledging and 
referencing sources. 
31.14 If the Head of Department is not satisfied that an offence has occurred but 
considers that the student has engaged in poor academic practice then the student 
should receive a warning, instruction about plagiarism and the necessity of properly 
acknowledging and referencing sources. 
31.15 The student will be notified in writing of the outcome. A copy will be kept on 
record in the Senate Office. 
31.16 If it is judged that there is no case for the student to answer, the student will be 
informed in writing and the piece of work in question will be marked in accordance 
with normal arrangements, without penalty. The Senate Office does not need to be 
notified of such instances. 
31.17 The Head of Department shall inform the Board of Examiners of any reduction 
in marks. The Board of Examiners shall not have the authority to revisit or alter 
academic penalties imposed by this process. 

Right of Appeal 
31.18 The student shall have the right of appeal to the Senate Assessors for 
Discipline in respect of any penalty imposed by the Head of Department. A student 
who wishes to appeal must do so in writing to the Head of the Senate Office within 14 
days of the date of the issue of the written decision of the Head of Department. 
31.19 The Senate Assessors for Discipline will consider an appeal against the 
penalty imposed by a Head of Department only on the grounds that: 
(i) new evidence has emerged which could not reasonably have been produced to 
the Head of Department; 
(ii) there has been defective procedure at the Head of Department level; 
(iii) the penalty imposed by the Head of Department was clearly unreasonable. 
The letter of appeal must clearly specify the details of any new evidence, the manner 
in which the procedures were defective or in what respects he or she believes the 
Head of Department has erred or been mistaken in imposing a penalty. The letter 
should also specify the remedy that the student seeks. 

Plagiarism in the work of a graduate 
31.20 The University will investigate any suspected case of plagiarism in the work of 
a graduate, which has already been assessed for an award of the University, to 
determine if the nature and extent of the plagiarism had been material to the award of 
the degree, diploma or certificate, or class within the degree. 
31.21 All such cases will be considered as severe plagiarism. The Head of 
Department will conduct an investigation and refer the case to the Clerk of Senate or 
the Head of the Senate Office in accordance with §31.6 above. 
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Absence 

If you are absent from the lab because of a medical problem or any other valid reason, 
you should: 

� Inform the lab head of your absence (by e-mail, or in person). You could 
also inform any other member of staff on duty in the lab. 

� Follow the university guidelines, as set out below. A self-certificate form can 
be obtained from one of the lab technicians, or staff demonstrating in the lab. 
The person to send the information to is given on the form. 

� Give a copy of the self-certificate or medical note to the lab technician. This is 
very important - it means that we can keep marks up to date. 

1. GENERAL ABSENCE DUE TO ILL-HEALTH OR OTHER 
REASON 

 
 Duration Reason Form of Notice Notice to be given 

to 
Follow-up action 

1.1 up to 5 
term-time 
days 
excluding 
Saturdays 
and Sundays 

ill-health GU student self-
certification 
form  

Senior Faculty 
Adviser 
(see form) 

Senior Faculty 
Adviser to inform 
student's Adviser and 
depts at discretion 

1.2 up to 5 
term-time 
days 
excluding 
Saturdays 
and Sundays 

other 
than ill-
health 

letter from 
student  

Senior Faculty 
Adviser 

Senior Faculty 
Adviser to inform 
student's Adviser and 
depts at discretion 

1.3 6 or more 
term-time 
days 
excluding 
Saturdays 
and Sundays 

ill-health Doctor's 
medical 
certificate 

Registry Registry to inform 
depts, student's 
Adviser and Senior 
Faculty Adviser* 

1.4 6 or more 
term-time 
days 
excluding 
Saturdays 
and Sundays 

other 
than ill-
health 

letter from 
student, family 
member or 
Adviser 

Registry Registry to inform 
depts, student's 
Adviser and Senior 
Faculty Adviser* 
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2. ABSENCE DUE TO ILL-HEALTH OR OTHER REASON 
WHICH PREVENTS THE SUBMISSION OF A COURSEWORK 

ASSIGNMENT BY THE DUE TIME (CONT'D OVERLEAF) 
 

 Duration Reason Form of 
Notice 

Notice to be given 
to 

Follow-up action 

2.1 up to 5 
term-time 
days 
excluding 
Saturdays 
and Sundays 

ill-health GU student self-
certification 
form � 

Senior Faculty 
Adviser 
(see form) 

Senior Faculty 
Adviser to inform 
student's Adviser and 
depts at discretion 

2.2 up to 5 
term-time 
days 
excluding 
Saturdays 
and Sundays 

other 
than ill-
health  

letter from 
student  

Senior Faculty 
Adviser 

Senior Faculty 
Adviser to inform 
student's Adviser and 
depts at discretion 

 
•  The Head of the Registry and the Senior Faculty Adviser will consult and 

decide when it is necessary to notify an absence to the SAAS/LEA. 
 

•  A Head of Department reserves the right to require a student to provide a 
doctor's medical certificate or report, for which the doctor may charge a fee.  
If payment of such a fee will cause the student financial hardship, he/she 
should seek advice from Registry on taking out an emergency Student Loan or 
applying to the Student Hardship Fund. 

  
  

 Duration Reason Form of Notice Notice to be given to Follow-up action 

2.3 6 or more 
term-time 
days 
excluding 
Saturdays 
and Sundays 

ill-health Doctor's medical 
certificate 

Registry Registry to inform 
depts, student's 
Adviser and Senior 
Faculty Adviser* 

2.4 6 or more 
term-time 
days 
excluding 
Saturdays 
and Sundays 

other than 
ill-health 

letter from 
student, family 
member or 
Adviser 

Registry Registry to inform 
depts, student's 
Adviser and Senior 
Faculty Adviser* 
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3. ABSENCE FROM ANY EXAMINATION DUE TO ILL-
HEALTH OR OTHER REASON 

 
 Durati

on 
Reaso
n 

Form of Notice Notice to 
be given 
to 

Follow-up action 

3.1 any ill-
health 

Doctor's medical report 
explaining the reason for 
absence or medical certificate 
only in the case of class exams 

Registry 
within 
one week 

Registry to inform all 
relevant depts and 
Senior Faculty 
Adviser 

3.2 any other 
than 
ill-
health 

letter from student, family 
member or Adviser or Student 
Counsellor 

Registry 
within 
one week 

Registry to inform all 
relevant depts and 
Senior Faculty 
Adviser 

 
 
*    The Head of the Registry and the Senior Faculty Adviser will consult and decide 

when it is necessary to notify an absence to the SAAS/LEA. 
 
 
 
 


